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Notice: The manufacturer reserves the right to make any changes and 
improvements to the products described in this manual at any time and without 
notice. This manual is copyrighted. This document may not, in whole or in part, 
be copied, reproduced, translated, or converted to any electronic medium or 
machine readable form, for commercial purposes, without prior written consent 
from the copyright holder.

Note: Although we provide assistance on our products both personally and 
through our literature, it is the complete responsibility of the user to determine 
the suitability of any product to their application.

The manufacturer does not warrant or assume responsibility for the use of its 
products in life support applications or systems.

Warranty
This product is warranted to the original purchaser for a period of one year 
from the date of purchase to be free of defects in material or workmanship. 
Under this warranty the product will be repaired or replaced at manufacturer’s 
option, without charge for parts or labor when the product is carried or shipped 
prepaid to the factory together with proof of purchase. This warranty does not 
apply to cosmetic items, nor to products that are damaged, defaced or otherwise 
misused or subjected to abnormal use. See “Application” under the Installation 
section. Where consistent with state law, the manufacturer shall not be liable for 
consequential economic, property, or personal injury damages. The manufacturer 
does not warrant or assume responsibility for the use of its products in life support 
applications or systems.

Conformity / Supplemental Information:
The product complies with the requirements of the Low Voltage Directive 2006/95/
EC and the EMC Directive 2004/108/EC and carries the CE Marking accordingly. 
Contact the manufacturer for more information.

	     11/19/2014  Rev.18	 DOC-CPMAN16C
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Thank you for purchasing an Cole-Parmer Gas Flow Controller. 

Please take the time to read the information contained in this manual. This will 
help to ensure that you get the best possible service from your instrument. This 
manual covers the following Cole-Parmer instruments:

	 MC-Series Mass Gas Flow Controllers

	 MCR-Series Mass Gas Flow Controllers

	 MCW-Series Low Pressure Drop Mass Flow Controllers

	 MCS-Series Mass Gas Flow Controllers

	 MCRS-Series Mass Gas Flow Controllers

MCS and MCRS-Series Flow Controllers are for use with certain aggressive gases 
(see page 67)

This includes MC and MCR-Series devices labeled as approved for CSA Class 1 
Div 2 and ATEX Class 1 Zone 2 hazardous environments. See pages 74 and 75 for 
Special Conditions regarding the use of CSA/ATEX labeled devices.

	 MCV-Series Mass Gas Flow Controllers

MCV-Series Flow Controllers have an integrated shut-off valve and are built for 
use with applications that require tight shut-off (see pages 29 and 63).

	 MCP-Series Mass Gas Flow Controllers

MCP-Series Flow Controllers are built with a high performance control valve for 
use with certain lower pressure applications (see page 65)

Full specifications for each device can be found on pages 54 through 70.
Please contact Cole-Parmer if you have any questions regarding the use 
or operation of this device.
Many Cole-Parmer instruments are built for specific applications. Two 
instruments with the same flow range and part number may look and 
act quite differently depending upon the application the instrument 
was built for. Care should be taken when moving an instrument from 
one application to another.
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GETTING STARTED

Small Valve Mass Flow Controller shown with an upstream valve configuration and 
connection port fittings

Large Valve Mass Flow Controller shown with a downstream valve configuration and 
connection port fittings

MOUNTING
MC-Series Gas Flow Controllers have holes on the bottom for mounting to flat 
panels. See pages 54 - 71. 
Small valve controllers (MC-Series) can usually be mounted in any position. 
Large valve controllers (MCR-Series) should be mounted so that the valve 
cylinder is vertical and upright. Mounting a large valve controller in another 
position increases the risk of leakage when the controller is being held closed 
by the spring force.
No straight runs of pipe are required upstream or downstream of the controller. 

Inlet Connection Port

Outlet Connection Port

Control Valve 8 Pin MiniDIN

Display Screen
Inlet Connection Port

Flow Direction Arrow

Outlet Connection Port

Power Jack
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PLUMBING
Your controller is shipped with plasti c plugs fi tt ed in the port openings. 
To lessen the chance of contaminati ng the fl ow stream do not remove 
these plugs unti l you are ready to install the device.

Make sure that the gas will fl ow in the directi on indicated by the fl ow arrow.
Standard MC-Series Gas Flow Controllers have female inlet and outlet port 
connecti ons. Welded VCR and other specialty fi tti  ngs may have male ports.
The inlet and outlet port sizes (process connecti ons) for diff erent fl ow ranges 
are shown on pages 54 - 71.
Controllers with M5 (10-32) ports have O-ring face seals and require no sealant 
or tape. Do not use tape with welded or o-ring fi tti  ngs.
For non M5 (10-32) ports use thread sealing Tefl on® tape to prevent leakage 
around the port threads. 
Do not wrap the fi rst two threads. This will minimize the possibility of getti  ng 
tape into the fl ow stream and fl ow body. 

Do not use pipe dopes or sealants on the process connecti ons as these 
compounds can cause permanent damage to the controller should they get 
into the fl ow stream.

When changing fi tti  ngs, carefully clean any tape or debris from the port threads.
We recommend the use of in-line sintered fi lters to prevent large parti culates 
from entering the measurement head of the instrument. Suggested maximum 
parti culate sizes are as follows:

5 microns for units with FS fl ow ranges of 0-1 sccm or less.
20 microns for units with FS fl ow ranges between 0-2 sccm and 0-1 slpm.
50 microns for units with FS fl ow ranges of 0-1 slpm or more.

PRESSURE
Maximum operati ng line pressure is 145 psig (1 MPa). 
If the line pressure is higher than 145 psig (1 MPa), use a pressure regulator upstream 
from the fl ow controller to reduce the pressure to 145 psig (1 MPa) or less. 
Cole-Parmer MCP mass fl ow controllers are fi tt ed with a high performance 
valve for low pressure applicati ons. 

MCP mass fl ow controllers have a maximum operati ng line pressure of 
80 psig. See page 65.

CAUTION!  E�������� ��� ������� ��������� ���� �������� 
��� ����� ��������� ������ �� ��� �����-����� ������������ 
�������� ����������.
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POWER AND SIGNAL CONNECTIONS
Power can be supplied to your controller through either the power jack (power jack 
not available on CSA/ATEX approved devices) or the 8 pin Mini-DIN connector. 

An AC to DC adapter which converts line AC power to DC voltage and current as 
specifi ed below is required to use the power jack. 

Small Valve controllers require a 12-30Vdc power supply with a 2.1 mm female 
positi ve center plug capable of supplying 250 mA. NOTE: 4-20mA analog output 
requires at least 15 Vdc.

Large Valve controllers require a 24-30 Vdc power supply with a 2.1 mm female 
positi ve center plug capable of supplying at least 750mA.

Standard 8 Pin Mini-DIN Pin-Out

Pin Functi on Mini-DIN 
cable color

1 Not Connected (or opti onal 4-20mA Primary Output Signal) Black

2 Stati c 5.12 Vdc [or opti onal Secondary Analog Output (4-20mA, 
5Vdc, 10Vdc) or Basic Alarm] Brown

3 Serial RS-232RX (receive) Input Signal Red

4 Meters/Gauges = Remote Tare (Ground to Tare)
Controllers = Analog Set-Point Input Orange

5 Serial RS-232TX (send) Output Signal Yellow
6 0-5 Vdc (or opti onal 0-10 Vdc) Output Signal Green
7 Power In (as described above) Blue
8 Ground (common for power, communicati ons and analog signals) Purple

Note: The above pin-out is applicable to all the fl ow meters and controllers with the 
Mini-DIN connector. The availability of diff erent output signals depends on the opti ons 
ordered. Opti onal confi gurati ons are noted on the unit’s calibrati on sheet.



 







CAUTION! D� ��� ������� ����� �� ���� 1 ������� 6 �� ��������� 
������ ��� �����!

It is common to mistake Pin 2 (labeled 5.12 Vdc Output) as the standard 0-5 Vdc 
analog output signal. In fact Pin 2 is normally a constant 5.12 Vdc that refl ects 
the system bus voltage and can be used as a source for the set-point signal.

For 6 Pin Locking Industrial Connector pin-outs see page 73.

1 2

3 4 5

6 7 8
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INPUT SIGNALS
Analog Input Signal

Apply analog input to Pin 4 as shown on page 8.

For 6 Pin Locking Industrial Connector pin-outs see page 73. 

Standard 0-5 Vdc is the standard analog input signal. Apply the 0-5 Vdc input 
signal to pin 4, with common ground on pin 8. The 5.12 Vdc output on pin 2 can 
be wired through a 50K ohm potenti ometer and back to the analog input on pin 
4 to create an adjustable 0-5 Vdc input signal source as shown below.

 

7 6

5 4 3

2 1

8

5.12 Vdc

50 KOhm 
Potentiometer

0-5 Vdc

Simple method for providing set-point to controllers

Opti onal 0-10 Vdc: If specifi ed at ti me of order, a 0-10 Vdc input signal can be 
applied to pin 4, with common ground on pin 8.

Opti onal 4-20 mA: If specifi ed at ti me of order, a 4-20 mA input signal can be 
applied to pin 4, with common ground on pin 8. 

NOTE: This is a current sinking device. The receiving circuit is essenti ally a 250 
ohm resistor to ground.  

NOTE: 4-20mA output requires at least 15 Vdc power input.

CAUTION!  D� ��� ������� ���� ������ �� “���� �������’” 
�������, �� ���� ���� ������� �������� �� ��� ��������� ��� ���� 
��� ��������. I� ��� ���� ��������� ���� �������� ���� ������� 
�������, ������ ��� � ������ �������� ��� � �������� ����� ������.
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RS-232 Digital Input Signal

To use the RS-232 input signal, connect the RS-232  Output Signal (Pin 5), the 
RS-232 Input Signal (Pin 3), and Ground (Pin 8) to your computer serial port as 
shown below. (See page 30 for details on accessing RS-232 input.)

DB9 to Mini-DIN Connection for RS-232 Signals













9 8 7 6



9876

15 3 24 1 532 4

Serial Cable End PC Serial Port


 









 











1

8 7 6

5

4

3

2

8 Pin MiniDIN Cable End 8 Pin MiniDIN Connector

9 Pin Serial Connection 8 Pin MiniDIN Connection
Pin Function Function Pin
5 Ground Ground 8
3 Transmit Receive 3
2 Receive Transmit 5
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OUTPUT SIGNALS

RS-232 Digital Output Signal

To use the RS-232 output signal, it is necessary to connect the RS-232 Output 
Signal (Pin 5), the RS-232 Input Signal (Pin 3), and Ground (Pin 8) to your 
computer serial port as shown on page 8. (See page 30 for details on accessing 
RS-232 output.)

Standard Voltage (0-5 Vdc) Output Signal

MC-Series fl ow controllers equipped with a 0-5 Vdc (opti onal 0-10 Vdc) will 
have this output signal available on Pin 6. This output is generally available in 
additi on to other opti onally ordered outputs. This voltage is usually in the range 
of 0.010 Vdc for zero fl ow and 5.0 Vdc for full-scale fl ow. The output voltage is 
linear over the enti re range. Ground for this signal is common on Pin 8.

Opti onal 0-10 Vdc Output Signal

If your controller was ordered with a 0-10 Vdc output signal, it will be available 
on Pin 6. (See the Calibrati on Data Sheet that shipped with your controller to 
determine which output signals were ordered.) This voltage is usually in the range 
of 0.010 Vdc for zero fl ow and 10.0 Vdc for full-scale fl ow. The output voltage is 
linear over the enti re range. Ground for this signal is common on Pin 8.

Opti onal Current (4-20 mA) Output Signal

If your controller was ordered with a 4-20 mA current output signal, it will 
be available on Pin 1. (See the Calibrati on Data Sheet that shipped with your 
controller to determine which output signals were ordered.) The current signal 
is 4 mA at 0 fl ow and 20 mA at the controller’s full scale fl ow. The output 
current is linear over the enti re range. Ground for this signal is common on Pin 
8. (Current output units require 15-30Vdc power.)

Opti onal 2nd Analog Output Signal

You may specify an opti onal 2nd analog output on Pin 2 at ti me of order. (See 
the Calibrati on Data Sheet that shipped with your controller to determine 
which output signals were ordered.) This output may be a 0-5 Vdc, 0-10 Vdc, or 
4-20 mA analog signal that can represent any measured parameter. With this 
opti onal output, a controller could output the mass fl ow rate (0-5 Vdc on pin 6) 
and the absolute pressure (0-5 Vdc on pin 2). 

If your device is CSA/ATEX approved or equipped with the opti onal six pin 
industrial connector, please contact Cole-Parmer.

CAUTION!  D� ��� ������� ���� ������ �� “���� �������’” 
�������, �� ���� ���� ������� �������� �� ��� ��������� ��� ���� 
��� ��������. I� ��� ���� ��������� ���� �������� ���� ������� 
�������, ������ ��� � ������ �������� ��� � �������� ����� ������.
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Typical Multi ple Device (Addressable) Wiring Confi gurati on

The easiest way to connect multi ple devices is with a Multi -Drop Box 
(see page 51).

CAUTION!  D� ��� ������� ���� ������ �� “���� �������’” 
�������, �� ���� ���� ������� �������� �� ��� ��������� ��� ���� 
��� ��������. I� ��� ���� ��������� ���� �������� ���� ������� 
�������, ������ ��� � ������ �������� ��� � �������� ����� ������.

5
3

2

Purple

Red
Yellow

Purple

Red
Yellow

5 4 3 2 1

9
8 7

6

Unit C

Unit B

Unit A

Female Serial Cable Front

Purple (Ground)

Red
Yellow
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Information for TFT (Color Display) Instruments
TFT (color display) instruments have a high contrast back-lit LCD display. 
TFT instruments operate in accordance with Cole-Parmer standard operating 
instructions for our monochrome menus and displays with the following 
differences. 

Multi-Color Display Color Codes:

GREEN: Green labels identify the parameters and/or adjustments 
associated with the button directly above or below the label.

WHITE: The color of each parameter is displayed in white while operating 
under normal conditions.

RED: The color of a parameter is displayed in red when operating 
conditions for that parameter exceed 128% of the device’s specifications.

YELLOW: Yellow is the equivalent of the selection arrow on the 
monochrome display.

LCD Contrast: 
LCD contrast is ranged from 1 to 11 on color displays with 11 being the greatest 
contrast.

Display On/Off: 
Pushing the button under the Cole-Parmer name will turn the device display on 
or off. This feature is not available on monochrome displays.

Technical Data for TFT (Color Display) Meters, Gauges and Controllers

The following specifications are applicable to Cole-Parmer TFT (color display) 
meters, gauges and controllers only. All other operating specifications are shown 
in the Technical Data page for standard Cole-Parmer instruments. All standard 
device features and functions are available and operate in accordance with the 
Cole-Parmer operating manual provided with the device. 

Specification Meter  or 
Gauge

Small Valve 
Controller

Large Valve 
Controller

Supply Voltage 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc
Supply Current 80 mA @ 12Vdc

70 mA @ 24Vdc
290 mA @ 12Vdc
200 mA @ 24Vdc

780 mA @ 
24Vdc
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#C
+21.50

   +0.00
     CCM

MENU/
TOTAL 

SETPT
0.000  

SCCM
Air

PSIA
+13.60

  +0.00
   SCCM

Main

+0.00

SETPT
0123.4

MENU

SLPM
+123.4

TOTAL/ 
TIMER

BATCH RESET

0000:09:59    SCC
00123.45
00123.45 Batch Done

The Main display shows pressure, 
temperature, set‑point, volumetric flow 
and mass flow.
Pressing the button adjacent to a 
parameter will make that parameter 
the primary display unit.
By hitting the MENU button at the 
bottom right of the screen you will 
enter the Select Menu display. 

If your controller was ordered with the 
Totalizer option (page 49), pushing the 
TOTAL button once will bring up the 
Totalizing Mode display. Pushing MENU 
will bring up the Select Menu display.

DISPLAYS AND MENUS
The device screen defaults to Main display as soon as power is applied to the controller.
Note: See page 28 to rotate the display 180°.

Select Menu
From Select Menu you can change 
the selected gas, interact with your 
RS-232 settings, read manufacturer’s 
data or access the control set-up 
display. 
Push MAIN to return to the Main display.

Totalizer (option only)

CONTROL
SETUP

RS232 
COMM

MFG
DATA

MAIN

MISC

GAS
SELECT

Select Menu
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MAIN 
This mode defaults on power up, with 
mass fl ow as the primary displayed 
parameter. 
The following parameters are displayed in 
the Main mode.
Gas Absolute Pressure: This sensor 
references hard vacuum and reads 
incoming pressure both above and below 
local atmospheric pressure. This parameter 
is moved to the primary display by pushing 
the butt on above PSIA. 
The engineering unit associated with 
absolute pressure is pounds per square 
inch absolute (psia). This can be converted 

to gage pressure (psig) by subtracti ng local atmospheric pressure from the 
absolute pressure reading:

PSIG = PSIA – (Local Atmospheric Pressure)
Gas Temperature: MC-Series fl ow 
controllers measure the incoming 
temperature of the gas fl ow. The 
temperature is displayed in degrees Celsius 
(°C). This parameter is moved to the primary 
display by pushing the butt on above °C.
Pushing the butt on again allows you to 
select 0C (Celsius), 0K (Kelvin), 0F (Fahrenheit) 
or 0R (Rankine) for the temperature scale. 
To select a temperature scale, use the UP 
and DOWN butt ons to positi on the arrow in 
front of the desired scale. 
Press SET to record your selecti on and 
return to the MAIN display. The selected 

temperature scale will be displayed on the screen.
Set Point: The set-point (SETPT)is shown in the upper right of the display. 

For informati on on changing the set-point see SETPT SOURCE, page 18.
Volumetric Flow Rate: This parameter is located in the lower left  of the display. 
It is moved to the primary display by pushing the butt on below CCM in this 
example. Your display may show a diff erent unit of measure.

#C
+21.50

+0.00
CCM

MENU/
TOTAL

SETPT
+0.00  

SCCM
Air

PSIA
+13.60

+0.00
SCCM

DOWN

CANCEL SET

  >#C
    #K
    #F
    #R
   

UP

+0.00

W��� ����� � ���� ���� ���������� �� �� �������� �������� 
����������, ��� ���� ���� ���� ��� ����������� ������ ��� ���� 
����������� ���������� (���� ����� + 28%) �� ��� ����. T��� ��� 
����� ���� ��� ���� �� ����� �� ���� �� ������ �������� ������. 

I� ��� �������� ��������� �� �� ��� �� ���� ����, ��� ��������� ����� 
���� ����������� ������ ���������. P����� ����� ��� ��������� �� ���� �� 
‘����-����’ ��������� ��� ��������.  
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Mass Flow Rate: The mass fl ow rate is the volumetric fl ow rate corrected to a 
standard temperature and pressure (typically 14.696 psia and 25 °C). 
This parameter is located in the lower middle of the display. It can be moved to 
the primary display by pushing the butt on below SCCM in this example. Your 
display may show a diff erent unit of measure preceded by the lett er S.

To get an accurate volumetric or mass fl ow rate, the gas being measured 
must be selected. See Gas Select, page 22. 

MENU: Pressing MENU switches the screen to the Select Menu display.

Flashing Error Message: An error message (MOV = mass overrange, VOV 
= volumetric overrange, POV = pressure overrange, TOV = temperature 
overrange) fl ashes when a measured parameter exceeds the range of the 
sensor. When any item fl ashes, neither the fl ashing parameter nor the 

mass fl ow measurement is accurate. Reducing the value of the fl ashing parameter 
to within specifi ed limits will return the unit to normal operati on and accuracy. 

If the unit does not return to normal operati on contact Cole-Parmer.
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SELECT MENU
From Select Menu you can change the selected gas, interact with your 
RS‑232 settings, read manufacturer’s data and access the control setup and 
miscellaneous screens.
Press the button next to the desired operation to bring that function to the screen.

Miscellaneous
Communications Select

Control Setup

Main

Manufacturer Data

An explanation for each screen can be found on the following pages.

#C
+21.50

+0.00
CCM MAIN

SETPT
0.000  

SCCM
Air

PSIA
+13.60

+0.00
SCCM

Gas Select

MODEL
INFO

BACK MAIN

LOOP
VAR

ON
AUTO PID MAIN

SETPT
SOURCE

MISC2

BACK MAIN

MISC1

DOWN

CANCEL SELECT

PAGE

>Recent
  Standard
  Factory Custom
  COMPOSER User Mixes
  Bioreactor
  Breathing
  Chromatography
  Fuel

UP

BACK MAIN

UNIT ID
A

BAUD
19200

SETPT
+0.00  

CONTROL
SETUP

RS232 
COMM

MFG
DATA

MAIN

MISC

GAS
SELECT

Select Menu

+ 0.00

C o l e - P a r m e r

Ph  800-323-4340

Fax 847-549-7676
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CONTROL SETUP 
Control Setup is accessed by pressing the button below Control Setup on the 
Select Menu display. From this screen you can select your set-point source, 
choose a loop variable and adjust the PID terms.

Press BACK to return to the Select Menu 
display. 
Press MAIN to return to the MAIN display
SETPT SOURCE – Pressing the button 
above SETPT SOURCE will allow you to 
select how the set point will be conveyed 
to your controller. 
Use the line-up and line-down buttons 
to move the arrow in front of the desired 
option. Then press SET.
Press CANCEL to return to the previous 
display. 
The controller will ignore any set-point 

except that of the selected set-point source and it will remember which input is 
selected even if the power is disconnected.

RS-232 refers to a remote digital RS-232 
set-point applied via a serial connection 
to a computer or PLC as described in the 
installation and RS-232 sections of this 
manual. 

Front Panel refers to a set-point applied 
directly at the controller. 

Front Panel input must be selected 
prior to changing the set-point at 
the device. 

Analog refers to a remote analog set-
point applied to Pin 4 of the Mini-DIN 
connector as described in the installation 

section of this manual. The standard analog input is 0-5 Vdc. 
To determine what type of analog set-point your controller has, refer to 
the Calibration Data Sheet that was included with your controller. 

If nothing is connected to Pin 4, and the controller is set for analog control, the 
device will generate random set-point values. 
NOTE: If your controller has the IPC (Integrated Potentiometer Control) option, 
the IPC dial will operate with the ANALOG set-point source selected.

SETPT refers to the set-point. This parameter may be changed using the display 
only if FRONT PANEL is selected as the Input. Press SETPT. Then use SELECT to 
choose the decimal with the arrow and the UP and DOWN buttons to change 
the value. Press SET to record your value. Press CLEAR to return to zero.

DOWN

CANCEL SET

UP

 >RS232
   FRONT PANEL
   ANALOG

LOOP
VAR

ON
AUTO PID MAIN

SETPT
SOURCE

SETPT
+0.0
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CAUTION!  N���� ����� � C��������� ���� � ���-���� ���-����� �� 
�� �������� �� ��������� �� ���� ����. T�� ���������� ���� ����� 
���� ����� �� ��� ����� �� �� ������� �� ����� ��� ���-�����. 
W��� ����� �� �� ����, ���� ��� ���� ��� ����� ���� HOT!

CONTROL SETUP (conti nued)
LOOP VAR—The selecti on of what variable 
to close the loop on is a feature unique to 
Cole-Parmer mass fl ow controllers. 
Pressing the LOOP VAR butt on on the 
Control Setup screen will allow you to 
change what variable is controlled. 
Use the line-up and line-down butt ons 
to move the arrow in front of the desired 
opti on. 
When the mass fl ow controller is supplied 
with the control valve upstream of the 
electronics porti on of the system, the unit 
can be set to control on outlet pressure 
(absolute pressures only) or volumetric 
fl ow rate, instead of mass fl ow rate. 
The change from mass to volume can 
usually be accomplished without much, if 
any, change in the P and D setti  ngs. 

When you change from controlling 
fl ow to controlling pressure, 
someti mes fairly radical changes 

must be made to the P & D variables. See 
page 20 – PID TUNING.
 Contact Cole-Parmer if you are having 
diffi  culti es with this procedure.

ON AUTO / OFF AUTO—refers to the standard auto-tare or “auto-zero” feature.

The auto-tare feature automati cally tares (takes the detected signal as zero) the 
unit when it receives a zero set-point for more than two seconds. 
A zero set-point results in the closing of the valve and a known “no fl ow” 
conditi on. This feature makes the device more accurate by periodically 
removing any cumulati ve errors associated with drift . 

It is recommended that the controller be left  in the default auto-tare ON 
mode unless your specifi c applicati on requires that it be turned off . 

DOWN

CANCEL SET

UP

 >Mass Flow
   Volumetric Flow
   Pressure

LOOP
VAR

ON
AUTO PID MAIN

SETPT
SOURCE

SETPT
+0.0
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PID TUNING

PID Values determine the performance 
and operation of your proportional control 
valve. These terms dictate control speed, 
control stability, overshoot and oscillation. 
All units leave the factory with a generic 
tuning designed to handle most applications. 
If you encounter issues with valve stability, 
oscillation or speed, fine tuning these 
parameters may resolve the problem.
Cole-Parmer controllers allow you to 
adjust the Proportional, Integral and 
Differential terms of the PID control loop. 
To change the PID loop parameters, push 
the button below PID.
Press LOOP TYPE. Then use the UP and 
DOWN buttons to select the appropriate 
PID control algorithm. Press SET.
See the following page for descriptions 
of the PID Loop Types (PID Control 
Algorithms).

P refers to the Proportional term of the 
PID loop. 
I refers to the Integral term of the PID loop. 
D refers to the Differential term of the PID 
loop. 
Press P, I or D. Then use SELECT to choose 
the digit with the arrow and the UP and 
DOWN buttons to change the value. Press 
SET to record your value. Press CLEAR to 
return to zero.

Before changing the P, I or D 
parameter, please record the initial 
value so that it can be returned to 

the factory setting if necessary.
Valve tuning can be complex. If you 
would like assistance, please contact 
Cole-Parmer for technical support.

I
00000

BACK
LOOP
TYPE MAIN

P
00100

D
02501

DOWN

CANCEL SET

UP

 > PD PID
   PD2I PID

LOOP
VAR

ON
AUTO PID MAIN

SETPT
SOURCE

SETPT
+0.0
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The PD algorithm is the PID algorithm used on most Cole-Parmer controllers.
It is divided into two segments:
The first compares the process value to the set-point to generate a proportional 
error. The proportional error is multiplied by the ‘P’ gain, with the result added 
to the output drive register. 
The second operates on the present process value minus the process value during 
the immediately previous evaluation cycle. This ‘velocity’ term in multiplied by 
the ‘D’ gain, with the result subtracted from the output drive register. 
The above additions to and subtractions from the output drive register 
are carried over from process cycle to process cycle, thus performing the 
integration function automatically. 
Increasing the ‘P’ gain will promote the tendency of the system to overshoot, 
ring, or oscillate. 
Increasing the ‘D’ gain will reduce the tendency of the system to overshoot. 
The PD2I algorithm is a PID algorithm used primarily for high performance 
pressure and flow control applications. 
It exhibits two basic differences from the PD algorithm that most controllers utilize.

1. Instead of applying a damping function based upon the rate of change of the 
process value, it applies a damping function based upon the square of the rate of 
change of the process value.
2. The damping function is applied directly to the proportional error term 
before that term is used in the proportional and integral functions of the 
algorithm. This provides a certain amount of ‘look ahead’ capability in the 
control loop.

Because of these differences, you will note the following:
1. Increasing ‘P’ gain can be used to damp out overshoot and slow oscillations 
in pressure controllers. You will know that ‘P’ gain is too high, when the 
controller breaks into fast oscillations on step changes in set-point. On flow 
controllers, too high a ‘P’ gain results in slower response times. Too low a ‘P’ 
gain results in overshoot and/or slow oscillation. A good starting value for ‘P’ 
gain is 200.
2. If the unit was originally shipped with the PD2I algorithm selected, the 
‘D’ gain value should be left at or near the factory setting because it relates 
primarily to the system phase lags. If you are changing from the default 
algorithm to the PD2I algorithm, you should start with a ‘D’ gain value of 20.
3. The ‘I’ gain is used to control the rate at which the process converges 
to the set-point, after the initial step change. Too low a value for ‘I’ gain 
shows up as a process value that jumps to near the set-point and then takes 
awhile to converge the rest of the way. Too high a value for ‘I’ gain results in 
oscillation. A good starting value for the ‘I’ gain is 200.
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GAS SELECT™
Gas Select allows you to set your 
device to up to 150 standard gases and 
mixes. You can also use COMPOSER to 
program and store up to 20 additional 
gas mixes.

Gas Select is accessed by pressing the 
button below GAS SELECT on the Select 
Menu display. 

To select a gas, use the UP and DOWN 
buttons to position the arrow in front of 
the desired gas category. 
»» Recent: Eight most recent selections
»» Standard: Gases and mixes standard 

on earlier Cole-Parmer instruments 
(page 40)
»» Factory Custom: Present only if customer 

requested gases were added at the factory
»» COMPOSER User Mixes: Gas mixes 

programmed by the user (page 23)
»» Bioreactor (page 42)
»» Breathing (page 43)
»» Chromatography (page 45)
»» Fuel (page 44)
»» Laser (page 44)
»» O2 Concentrator (page 45)
»» Pure Corrosive* (page 39)
»» Pure Non-Corrosive (page 38)
»» Refrigerant* (page 40)
»» Stack (page 45)
»» Welding (page 41)

Press PAGE to view a new page in the gas category list.

Press SELECT to view the gases in the selected category. Align the arrow with the 
desired gas. Press SET to record your selection and return to the MAIN display. 
The selected gas will be displayed on the screen.

* Pure Corrosive and Refrigerant gases are only available on S-Series instruments 
that are compatible with these gases.

Note: Gas Select may not be available on units ordered with a custom gas or blend.

See pages 38 -45 for a full list of gases in each category. 

DOWN

CANCEL SET

PAGE

>Recent
  Standard
  Factory Custom
  COMPOSER User Mixes
  Bioreactor
  Breathing
  Chromatography
  Fuel 

UP

DOWN

CANCEL SET

PAGE

> Fuel
  Laser
  O2 Concentrator
  Pure Corrosive
  Pure Non-Corrosive
  Refrigerant
  Stack
  Welding

UP
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COMPOSER™
COMPOSER™ allows you to program 
and save up to 20 custom gas mixes 
containing 2 to 5 component gases 
found in the gas lists (pages 38-45). The 
minimum resolution is 0.01%.

COMPOSER is accessed by selecting 
COMPOSER User Mixes on the GAS 
SELECT display.

Press SET when the arrow is aligned 
with Add Mix.

Name the mix by pressing the UP and 
DOWN buttons for letters, numerals 
and symbols. 

CHANGE CASE – Toggles the letter 
case. Letters remain in selected case 
until CHANGE CASE is pushed again.

Press SET to save the name.

After naming the mix, press ADD GAS 
and select the gas category and the 
component gas.

Select the digit with arrow and adjust 
the % with the UP and DOWN buttons. 
Press set to save. Add up to 4 more 
gases as needed. The total must equal 
100% or an error message will appear.

GAS OPTNS allows you to adjust the 
percentage of the constituents or 
delete a gas from the mix. Gas mixes 
cannot be adjusted after they have 
been saved.

DOWN

CANCEL SET

>Add Mix: 20 Free
UP

DOWN

BACK/
CANCEL

CHANGE 
CASE SET

NEXT
LETTER

COMPOSER Mix name:

	 MyGas
	 ------˄

UP

ADD GAS

BACK/
CANCEL

CHANGE 
CASE SET

GAS 
OPTNS

COMPOSER Mix: MyGAS

      0.00% of Total

EDIT 
NAME
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Once the mix has been saved, you 
may press CREATE SIMILAR to 
compose an additional mix based 
on the mix you have just saved. 
This CREATE SIMILAR option is not 
available after leaving this screen.

Press CREATE NEW to add a 
completely new mix.

Press SELECT MIXTURE to bring the 
custom mix onto the MAIN display.

MAIN
SELECT 
MIXTURE

CREATE 
SIMILAR

COMPOSER USER MIX
MyGas

HAS BEEN SAVED

CREATE 
NEW

DOWN

BACK/
CANCEL CLEAR SET

SELECT 
DIGIT

Percent of Air:

	 50.00
	 ˄

UP DOWN

BACK/
CANCEL CLEAR SET

SELECT 
DIGIT

Percent of Ar Argon:

	 30.00
	 ˄

UP

DOWN

BACK/
CANCEL CLEAR SET

SELECT 
DIGIT

Percent of He Helium:

	 20.00
	 ˄

UP ADD GAS

CANCEL SAVE

GAS 
OPTNS

COMPOSER Mix: MyGAS
   50% Air
   30% AR Argon
   20% He Helium
 100.00%  Total

EDIT 
NAME
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COMMUNICATION SELECT
Access Communication Select by pressing 
the button above RS232 COMM on the 
Select Menu display. 

Unit ID – Valid unit identifiers are the 
letters A-Z and @. The identifier allows 
you to assign a unique address to each 
device so that multiple units can be 
connected to a single RS‑232  computer 
port. 
Press UNIT ID. Use the UP and DOWN 
buttons to change the Unit ID. Press SET to 
record the ID. Press Reset to return to the 
previously recorded Unit ID.
Any Unit ID change will take effect when 
Communication Select is exited.
If the symbol @ is selected as the Unit 
ID, the device will enter streaming mode 
when Communication Select is exited. 
See RS-232 Communications (page 30) for 
information about the streaming mode.

Baud – Both this instrument and your 
computer must send/receive data at the 
same baud rate. The default baud rate for 
this device is 19200 baud. 
Press BAUD. Use the UP and DOWN 
buttons  to select the baud rate that 
matches your computer. The choices are 
38400, 19200, 9600, or 2400 baud. Press 
SET to record the baud rate.
Any baud rate change will not take effect 
until power to the unit is cycled.

UP

BACK RESET A SET

UNIT ID
C

DOWN

DOWN

BACK SET

BAUD UP

19200

BACK MAIN

UNIT ID
A

BAUD
19200

C
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MISCELLANEOUS 
Miscellaneous is accessed by pressing the MISC button on the Select Menu display. 
Next select either MISC1 or MISC2. 

MISC1 will display as shown at left.
ZERO BAND refers to Display Zero Deadband. 
Zero deadband is a value below which the display 
jumps to zero. This deadband is often desired to 
prevent electrical noise from showing up on the 
display as minor flows or pressures that do not 
exist. Display Zero Deadband does not affect the 
analog or digital signal outputs.
ZERO BAND can be adjusted between 0 and 
3.2% of the sensor’s Full Scale (FS). 
Press ZERO BAND. Then use SELECT to choose 
the digit with the arrow and the UP and DOWN 
buttons to change the value. Press SET to record 
your value. Press CLEAR to return to zero.
Pressure Averaging and Flow Averaging may 
be useful to make it easier to read and interpret 
rapidly fluctuating pressures and flows. Pressure 
and flow averaging can be adjusted between 1 
(no averaging) and 256 (maximum averaging). 
These are geometric running averages where 
the number between 1 and 256 can be 
considered roughly equivalent to the response 
time constant in milliseconds. 

This can be effective at “smoothing” high frequency process oscillations such as 
those caused by diaphragm pumps. 
Press PRESS AVG. Then use SELECT to choose the digit with the arrow and the UP and 
DOWN buttons to change the value. Press SET to record your value. Press CLEAR to 
return to zero.

Press FLOW AVG. Then use SELECT to choose the 
digit with the arrow and the UP and DOWN buttons 
to change the value. Press SET to record your value. 
Press CLEAR to return to zero.
Setting a higher number will equal a smoother 
display. 
LCD CONTRAST: The display contrast can be 
adjusted between 0 and 30, with zero being the 
lightest and 30 being the darkest. Use the UP 
and DOWN buttons to adjust the contrast. Press 
SET when you are satisfied. Press CANCEL to 
return to the MISC display.

PRESS
AVG

BACK

LCD

CONTRAST MAIN

ZERO
BAND

FLOW
AVG

DOWN

CANCEL CLEAR SET

UP SELECT

0.0

>

DOWN

CANCEL RESET SET

UP

11
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MISC2 will display as shown at left. 
STP refers to the functions that allow your 
selection of standard temperature and 
pressure conditions. This feature is generally 
useful for comparison purposes to other 
devices or systems using different STP 
parameters. 
The STP menu is comprised of the STP TEMP 
and STP PRESS screens. 

STP TEMP allows you to select from seven 
standard temperature protocols. The arrow 
position will automatically default to the 
currently stored value. 

Once a selection has been made and recorded 
using the SET button, a change acknowledgement 
message will be displayed on screen. 

Selecting RETURN will revert screen to the 
Main display. If the SET selection is already 
the currently stored value, a message 
indicating that fact will appear. 
STP PRESS enables you to select from one of 
two standard pressure settings. 

The arrow position will automatically default 
to the currently stored value. 

Once a selection has been made and recorded using the SET button, a change 
acknowledgement message will be displayed on screen. 

Selecting RETURN will revert screen to the Main display. If the SET selection is 
already the currently stored value, a message indicating that fact will appear. 

DIAG
TEST

BACK MAIN

STP ROTATE 
DISP

STP
PRESS

BACK MAIN

STP
TEMP

DOWN

RETURN

0  C
15  C
15.56  C   60F
20  C
21.11   C   70F
25  C
37  C

STP CHANGED 21.11  C

SET

UP

>

DOWN

RETURN

1 atm  14.696 PSIA
1 bar  100KPa 14.50P

--- STP ALREADY SET ---

SET

UP

>

STP TEMP Display STP PRESS Display
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BACK MAIN

SCROLL
R8:     AP Sig	 7871
R9:     Temp Sig	 39071
R10:    DP Side	 9986
R11:     DP Brdg	 36673
R13:    AP Brdg	 36673
R16:    Meter Fun	 199
R18:    Power Up	 32768

DIAG TEST: This diagnostic screen displays 
the initial register values configured by the 
factory, which is useful for noting factory 
settings prior to making any changes. It is 
also helpful for troubleshooting with Cole-
Parmer customer service personnel.
Select the DIAG TEST button from the MISC2 
screen to view a list of select register values. 
Pressing the SCROLL button will cycle the 
display through the register screens. An 
example screen is shown at left.

Press ROTATE DISP and SET to Inverted 180° if your device is inverted. The 
display and buttons will rotate together.

MANUFACTURER DATA
Manufacturer Data is accessed by pressing 
the MFG DATA button on the Select Menu 
display. 

The initial display shows the name and 
telephone number of the manufacturer.

Press MODEL INFO to show important 
information about your flow device 
including the model number, serial 
number, and date of manufacture. 

Press BACK to return to the MFG DATA 
display.

Push MAIN to return to the Main display.

MODEL
INFO

BACK MAIN

C o l e - P a r m e r

Ph    800-323-4340

Fax  847-549-7676

BACK MAIN

MODEL:  � MC-100SCCM-D
SERIAL NO: � 100903
DATE  MFG:    � 10/7/2014
DATE  CAL:    � 10/9/2014
CAL  BY:  � DL
SW REV:  � 5v00.G
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MCV Controller Operating Notes
Cole-Parmer’s MCV mass flow controller is equipped with an integrated 
Swagelok® positive shutoff valve. 
The normally closed valve is air actuated and will remain closed until it is 
connected to an air source supplying between 60 and 120 psig of air pressure.
Once the appropriate amount of air pressure is supplied to the shutoff valve, 
it will open, allowing flow through the mass controller. Air pressure must be 
removed from the shutoff valve in order for the valve  to close.
A common method for actuating the shutoff valve incorporates a three-way 
solenoid valve (below).
Air pressure is applied to one side of the solenoid valve while the other side of 
the solenoid is left open to atmosphere.
When the solenoid is energized, air pressure is delivered to the shutoff valve, 
allowing it to open. 
When the solenoid is returned to a relaxed state, air pressure is removed from 
the shutoff valve, allowing it to close. The air pressure is vented to atmosphere.
Solenoid valves for use with the MCV mass flow controller can be ordered from 
Cole-Parmer.
Note: All standard MC-Series device features and functions are available on the 
MCV‑Series and operate in accordance with the standard MC-Series operating 
instructions.

Three-way Solenoid Valve

MCV Controller

 Vent

 Air Supply

MCV controller and three-way solenoid valve.
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RS-232 Output and Input
Configuring HyperTerminal®:
1.	 Open your HyperTerminal® RS-232 terminal program (installed under the 

“Accessories” menu on all Microsoft Windows® operating systems).
2.	 Select “Properties” from the file menu.
3.	 Click on the “Configure” button under the “Connect To” tab. Be sure the 

program is set for: 19,200 baud (or matches the baud rate selected in the RS-
232 communications menu on the meter) and an 8-N-1-None (8 Data Bits, 
No Parity, 1 Stop Bit, and no Flow Control) protocol.

4.	 Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI 
or Auto Detect.

5.	 Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line 
Feeds” box is not checked and the “Echo Typed Characters Locally” box and 
the “Append Line Feeds to Incoming Lines” boxes are checked. Those settings 
not mentioned here are normally okay in the default position.

6.	 Save the settings, close HyperTerminal® and reopen it.
Streaming Mode
In the default Polling Mode, the screen should be blank except the blinking cursor. In 
order to get the data streaming to the screen, hit the “Enter” key several times to clear 
any extraneous information. Type “*@=@” followed by “Enter” (or using the RS-232 
communication select menu, select @ as identifier and exit the screen). If data still 
does not appear, check all the connections and COM port assignments.
Streaming Mode – Advanced 
The streaming data rate is controlled by register 91. The recommended default rate 
of data provision is once every 50 milliseconds and this is suitable for most purposes. 
If a slower or faster streaming data rate is desired, register 91 can be changed to a 
value from 1 millisecond to 65535 milliseconds, or slightly over once every minute. 
Below approximately 40 milliseconds, data provision will be dependent upon 
how many parameters are selected. Fewer data parameters can be streamed 
more quickly than more. It is left to the user to balance streaming speed with 
number of parameters streamed. 
To read register 91, type “*r91” followed by “Enter”. 
To modify register 91, type “*w91=X”, where X is a positive integer from 1 to 
65535, followed by “Enter”. 
To return to the recommended factory default streaming speed, type “*w91= 50”.
Changing From Streaming to Polling Mode: 
When the meter is in the Streaming Mode, the screen is updated approximately 
10-60 times per second (depending on the amount of data on each line) so that 
the user sees the data essentially in real time. It is sometimes desirable, and 
necessary when using more than one unit on a single RS-232 line, to be able to 
poll the unit.
In Polling Mode the unit measures the flow normally, but only sends a line of data 
when it is “polled”. Each unit can be given its own unique identifier or address. 
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Unless otherwise specified each unit is shipped with a default address of capital A. 
Other valid addresses are B thru Z.
Once you have established communication with the unit and have a stream of 
information filling your screen:
1.	 Type *@=A followed by “Enter” (or using the RS-232 communication select 

menu, select A as identifier and exit the screen) to stop the streaming mode 
of information. Note that the flow of information will not stop while you 
are typing and you will not be able to read what you have typed. Also, the 
unit does not accept a backspace or delete in the line so it must be typed 
correctly. If in doubt, simply hit enter and start again. If the unit does not 
get exactly what it is expecting, it will ignore it. If the line has been typed 
correctly, the data will stop.

2.	 You may now poll the unit by typing A followed by “Enter”. This does an 
instantaneous poll of unit A and returns the values once. You may type A 
“Enter” as many times as you like. Alternately you could resume streaming 
mode by typing *@=@ followed by “Enter”. Repeat step 1 to remove the 
unit from the streaming mode.

3.	 To assign the unit a new address, type *@=New Address, e.g. *@=B. Care 
should be taken not to assign an address to a unit if more than one unit is 
on the RS-232 line as all of the addresses will be reassigned. Instead, each 
should be individually attached to the RS-232 line, given an address, and 
taken off. After each unit has been given a unique address, they can all be 
put back on the same line and polled individually.

Sending a Set-point via RS-232: To send a set-point via RS-232, “Serial” must be 
selected under the “Input” list in the control set up mode. 
Method 1:  Set-point may be set in floating point in serial communication using 
serial command (UnitID)SX.YZ 

Example:  AS4.54 results in Unit ID A changing set-point to 4.54.  
Method 2: Type in a number between 0 and 65535 (2% over range), where 64000 
denotes full-scale flow rate, and hit “Enter”. 
The set-point column and flow rates should change accordingly. If they do not, 
try hitting “Enter” a couple of times and repeating your command. The formula 
for performing a linear interpolation is as follows:

Value = (Desired Set-point X 64000) / Full Scale Flow Range
For example, if your device is a 100 slpm full-scale unit and you wish to apply a 
set-point of 35 slpm you would enter the following value:
 	 22400 = (35 slpm X 64000) / 100 slpm
If the controller is in polling mode as described in Changing from Streaming 
Mode to Polling Mode, the set-point must be preceded by the address of the 
controller. For example, if your controller has been given an address of D, the 
set-point above would be sent by typing:

 	 D22400 followed by “Enter”
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To adjust the Proportional and Differential (P&D) terms via RS-232:

Type *@=A followed by “Enter” to stop the streaming mode of information.

To adjust the “P” or proportional term of the PID controller, type *R21 followed 
by “Enter”.

The computer will respond by reading the current value for register 21 between 
0-65535. It is good practice to write this value down so you can return to the 
factory settings if necessary. Enter the value you wish to try by writing the new 
value to register 21. For example, if you wished to try a “P” term of 220, you 
would type *W21=220 followed by “Enter” where the bold number denotes the 
new value.

The computer will respond to the new value by confirming that 21=220. To 
see the effect of the change you may now poll the unit by typing A followed 
by “Enter”. This does an instantaneous poll and returns the values once.  You 
may type A “Enter” as many times as you like. Alternately you could resume 
streaming mode by typing *@=@ followed by “Enter”. Repeat step 3 to remove 
the unit from the streaming mode.

To adjust the “D” or proportional term of the PID controller, type *R22 followed 
by “Enter”.

The computer will respond by reading the current value for register 22 between 
0-65535. It is good practice to write this value down so you can return to the 
factory settings if necessary. Enter the value you wish to try by writing the new 
value to register 22. For example, if you wished to try a “D” term of 25, you 
would type *W22=25 followed by “Enter” where the bold number denotes the 
new value. 

The computer will respond to the new value by confirming that 22=25. To see the 
effect of the change you may now poll the unit by typing A followed by “Enter”. 
This does an instantaneous poll and returns the values once. You may type A 
“Enter” as many times as you like. Alternately you could resume streaming mode 
by typing *@=@ followed by “Enter”. Repeat.

You may test your settings for a step change by changing the set-point. To do 
this type A32000 (A is the default single unit address, if you have multiple 
addressed units on your RS-232 line the letter preceding the value would change 
accordingly.) followed by “Enter” to give the unit a ½ full scale set-point. Monitor 
the unit’s response to the step change to ensure it is satisfactory for your needs. 
Recall that the “P” term controls how quickly the unit goes from one set-point to 
the next, and the “D” term controls how quickly the signal begins to “decelerate” 
as it approaches the new set-point (controls the overshoot).
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Gas Select – The selected gas can be changed via RS-232 input. To change the 
selected gas, enter the following commands:

	 In Polling Mode:	 Address$$#<Enter>	    (e.g. B$$#<Enter>)

Where # is the number of the gas selected from the table below. Note that 
this also corresponds to the gas select menu on the flow controller screen (the 
Standard gas category is shown in the example below):

# GAS
0 Air Air
1 Argon     Ar
2 Methane    CH4
3 Carbon Monoxide    CO
4 Carbon Dioxide    CO2
5 Ethane    C2H6
6 Hydrogen    H2
7 Helium    He
8 Nitrogen    N2
9 Nitrous Oxide    N2O

10 Neon    Ne
11 Oxygen    O2
12 Propane    C3H8
13 normal-Butane    n-C4H10
14 Acetylene    C2H2
15 Ethylene    C2H4
16 iso-Butane i-C2H10
17 Krypton Kr
18 Xenon Xe
19 Sulfur Hexafluoride SF6
20 75% Argon / 25% CO2 C-25
21 90% Argon / 10% CO2 C-10
22 92% Argon / 8% CO2 C-8
23 98% Argon / 2% CO2 C-2
24 75% CO2 / 25% Argon C-75
25 75% Argon / 25% Helium HE-75
26 75% Helium / 25% Argon HE-25

27 90% Helium / 7.5% Argon / 2.5% CO2
(Praxair - Helistar® A1025) A1025

28 90% Argon / 8% CO2 / 2% Oxygen
(Praxair - Stargon® CS) Star29

29 95% Argon / 5% Methane P-5

For example, to select Propane, enter:  $$12<Enter>
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Creating and Deleting Gas Mixtures with COMPOSER™ using RS-232
Note: All commands must be prefixed with the unit ID if the unit is not in 
streaming mode.
You may create and store up to 20 gas mixtures containing up to five constituent 
gases each. 
Create a Gas Mixture
To create a gas mixture, enter a single-line command according to the following 
formula: [Unit ID]GM [Gas Name] [Gas Mix Number] [Percent 1] [Gas Number 1] 
[Percent 2] [Gas Number 2] …

Gas Name: Name your mixture using a maximum of 6 characters. 
Gas Mix Number: COMPOSER™ user mixes have gas numbers between 236 
and 255. You can assign any number in this range to your new mixture. If 
another mixture with the same number exists, it will be overwritten, even if 
that gas is currently selected on the unit. If you enter a 0 here, the new mix will 
be assigned the next available number between 236 and 255. 
Percent 1: The percentage of the first constituent gas. The percentage of each 
constituent must be between 0.01 and 99.99. Values entered beyond two 
decimal points will be rounded to the nearest 0.01%.
Gas Number 1: The gas number of the first constituent gas.
Percent 2: The percentage of the first constituent gas. Values entered beyond 
two decimal points will be rounded to the nearest 0.01%.
Gas Number 2: The gas number of the first constituent gas.
Additional Gases: (Optional) The above pattern of [Percent] + [Gas Number] 
may be repeated for additional constituent gases up to a total of 5 constituents. 
The sum of all percentages must be 100.00.

On success, the unit ID (if set) is returned followed by a space. The number of 
the gas mixture is then returned, followed by the percentages and names of each 
constituent in the mix. If the gas is not successfully mixed, a "?" is returned.
Delete a Gas Mixture
To delete a gas mixture, enter: 

[Unit ID]GD [Gas Number]: The number of the COMPOSER™ user mixture you 
wish to delete from the unit

Only COMPOSER™ user mixtures can be deleted with this command.
On success, the unit ID (if set) is returned followed by a space and the number of 
the gas deleted. If the gas is not successfully deleted, a "?" is returned.
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Collecting Data:
The RS-232 output updates to the screen many times per second. Very short-term 
events can be captured simply by disconnecting (there are two telephone symbol 
icons at the top of the HyperTerminal® screen for disconnecting and connecting) 
immediately after the event in question. The scroll bar can be driven up to the event 
and all of the data associated with the event can be selected, copied, and pasted into 
Microsoft® Excel® or other spreadsheet program as described below.
For longer term data, it is useful to capture the data in a text file. With the desired 
data streaming to the screen, select “Capture Text” from the Transfer Menu. Type 
in the path and file name you wish to use. Push the start button. When the data 
collection period is complete, simply select “Capture Text” from the Transfer Menu 
and select “Stop” from the sub-menu that appears.
Data that is selected and copied, either directly from HyperTerminal® or from a text 
file can be pasted directly into Excel®. When the data is pasted it will all be in the 
selected column. Select “Text to Columns...” under the Data menu in Excel® and a 
Text to Columns Wizard (dialog box) will appear. 
Make sure that “Fixed Width” is selected under Original Data Type in the first dialog 
box and click “Next”. In the second dialog box, set the column widths as desired, 
but the default is usually acceptable. Click on “Next” again.  In the third dialog 
box, make sure the column data format is set to “General”, and click “Finish”. This 
separates the data into columns for manipulation and removes symbols such as 
the plus signs from the numbers. Once the data is in this format, it can be graphed 
or manipulated as desired.	        For extended term data capture see page 38.

Data Format:
The data stream on the screen represents the flow parameters of the main mode 
in the units shown on the display. 
For mass flow controllers, there are six columns of data representing pressure, 
temperature, volumetric flow, mass flow, set-point, and the selected gas 
The first column is absolute pressure (normally in psia), the second column is 
temperature (normally in °C), the third column is volumetric flow rate (in the 
units specified at time of order and shown on the display), the fourth column is 
mass flow (also in the units specified at time of order and shown on the display), 
the fifth column is the currently selected set-point value, the sixth column 
designates the currently selected gas. For instance, if the controller was ordered 
in units of scfm, the display on the controller would read 2.004 scfm and the last 
two columns of the output below would represent volumetric flow and mass 
flow in cfm and scfm respectively.

+014.70 +025.00 +02.004 +02.004 2.004 Air
+014.70 +025.00 +02.004 +02.004 2.004 Air
+014.70 +025.00 +02.004 +02.004 2.004 Air
+014.70 +025.00 +02.004 +02.004 2.004 Air
Pressure Temp Vol. Flow Mass Flow Set Point Gas

MC-Series Mass Flow Controller Data Format
Note: On units with the totalizer function, the sixth column will be the totalizer 
value, with gas select moving to a seventh column.
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Sending a Simple Script File to HyperTerminal®
It is sometimes desirable to capture data for an extended period of time. Standard 
streaming mode information is useful for short term events, however, when 
capturing data for an extended period of time, the amount of data and thus the 
file size can become too large very quickly. Without any special programming 
skills, the user can use HyperTerminal® and a text editing program such as 
Microsoft® Word® to capture text at user defined intervals.
1. Open your text editing program, MS Word for example.
2. Set the cap lock on so that you are typing in capital letters.
3. Beginning at the top of the page, type A<Enter> repeatedly. If you’re using MS 
Word, you can tell how many lines you have by the line count at the bottom of the 
screen. The number of lines will correspond to the total number of times the flow 
device will be polled, and thus the total number of lines of data it will produce.
For example:	 A

	 A
	 A
	 A
	 A
	 A
will get a total of six lines of data from the flow meter, but you can 
enter as many as you like.

The time between each line will be set in HyperTerminal.
4. When you have as many lines as you wish, go to the File menu and select save. 
In the save dialog box, enter a path and file name as desired and in the “Save as 
Type” box, select the plain text (.txt) option. It is important that it be saved as a 
generic text file for HyperTerminal to work with it.
5. Click Save.
6. A file conversion box will appear. In the “End Lines With” drop down box, select 
CR Only. Everything else can be left as default.
7. Click O.K.
8. You have now created a “script” file to send to HyperTerminal. Close the file 
and exit the text editing program.
9. Open HyperTerminal and establish communication with your flow device as 
outlined in the manual.
10. Set the flow device to Polling Mode as described in the manual. Each time you 
type A<Enter>, the meter should return one line of data to the screen.
11. Go to the File menu in HyperTerminal and select “Properties”.
12. Select the “Settings” tab.
13. Click on the “ASCII Setup” button.
14. The “Line Delay” box is defaulted to 0 milliseconds. This is where you will tell 
the program how often to read a line from the script file you’ve created. 1000 
milliseconds is one second, so if you want a line of data every 30 seconds, you 
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would enter 30000 into the box. If you want a line every 5 minutes, you would 
enter 300000 into the box.

15. When you have entered the value you want, click on OK and OK in the 
Properties dialog box.

16. Go the Transfer menu and select “Send Text File…” (NOT Send File…).

17. Browse and select the text “script” file you created.

18. Click Open.

19. The program will begin “executing” your script file, reading one line at a time 
with the line delay you specified and the flow device will respond by sending one 
line of data for each poll it receives, when it receives it.
You can also capture the data to another file as described in the manual under 
“Collecting Data”. You will be simultaneously sending it a script file and capturing 
the output to a separate file for analysis.

Operating Principle

All M-Series Gas Flow Meters (and MC-Series Gas Flow Controllers) are based on the 
accurate measurement of volumetric flow. The volumetric flow rate is determined 
by creating a pressure drop across a unique internal restriction, known as a Laminar 
Flow Element (LFE), and measuring differential pressure across it. The restriction is 
designed so that the gas molecules are forced to move in parallel paths along the 
entire length of the passage; hence laminar (streamline) flow is established for the 
entire range of operation of the device. Unlike other flow measuring devices, in 
laminar flow meters the relationship between pressure drop and flow is linear. 

STANDARD GAS DATA TABLES: Those of you who have older Cole-Parmer 
products may notice small discrepancies between the gas property tables of 
your old and new units. Cole-Parmer has incorporated the latest data sets from 
NIST (including their REFPROP 9 data where available) in our products’ built-in 
gas property models. Be aware that the calibrators that you may be using may 
be checking against older data sets such as the widely distributed Air Liquide 
data. This may generate apparent calibration discrepancies of up to 0.6% of 
reading on well behaved gases and as much as 3% of reading on some gases such 
as propane and butane, unless the standard was directly calibrated on the gas in 
question. 
As the older standards are phased out, this difference in readings will cease to 
be a problem. If you see a difference between the Cole-Parmer meter and your 
in-house standard, in addition to calling Cole-Parmer at, call the manufacturer 
of your standard for clarification as to which data set they used in their 
calibration. This comparison will in all likelihood resolve the problem.
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TROUBLESHOOTING

Display does not come on or is weak.
Check power and ground connections. Please reference the technical specifications 
(pages 54 - 71) to assure you have the proper power for your model.

Flow reading is approximately fixed either near zero or near full scale 
regardless of actual line flow.
Differential pressure sensor may be damaged. A common cause of this problem 
is instantaneous application of high‑pressure gas as from a snap acting solenoid 
valve upstream of the meter. If you suspect that your pressure sensor is 
damaged please discontinue use of the controller and contact Cole-Parmer.

Displayed mass flow, volumetric flow, pressure or temperature is flashing and 
message MOV, VOV, POV or TOV is displayed:
Our flow meters and controllers display an error message (MOV = mass overrange, 
VOV = volumetric overrange, POV = pressure overrange, TOV = temperature 
overrange) when a measured parameter exceeds the range of the sensors in the 
device. When any item flashes on the display, neither the flashing parameter 
nor the mass flow measurement is accurate. Reducing the value of the flashing 
parameter to within specified limits will return the unit to normal operation and 
accuracy. If the unit does not return to normal contact Cole-Parmer.

After installation, there is no flow.
Cole-Parmer MC controllers incorporate normally closed valves and require a 
set‑point to operate. Check that your set-point signal is present and supplied to 
the correct pin and that the correct set-point source is selected under the SETPT 
SOURCE list in the control set up display. Also check that the unit is properly 
grounded. 

The flow lags below the set-point.
Be sure there is enough pressure available to make the desired flow rate. If 
either the set-point signal line and/or the output signal line is relatively long, it 
may be necessary to provide heavier wires (especially ground wiring) to negate 
voltage drops due to line wire length. An inappropriate PID tuning can also 
cause this symptom if the D term is too large relative to the P term. See pages 
20 and 21 for more information on PID tuning.

Controller is slow to react to a set-point change or imparts an oscillation to the flow.
An inappropriate PID tuning can cause these symptoms. Use at conditions 
considerably different than those at which the device was originally set up 
can necessitate a re-tuning of the PID loop. See pages 20 and 21 for more 
information on PID tuning.

The output signal is lower than the reading at the display.
This can occur if the output signal is measured some distance from the meter, 
as voltage drops in the wires increase with distance. Using heavier gauge wires, 
especially in the ground wire, can reduce this effect.
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Meter does not agree with another meter I have in line.
Volumetric meters are affected by pressure drops. Volumetric flow meters 
should not be compared to mass flow meters. Mass flow meters can be 
compared against one another provided there are no leaks between the two 
meters and they are set to the same standard temperature and pressure. Both 
meters must also be calibrated (or set) for the gas being measured. M-Series 
mass flow meters are normally set to Standard Temperature and Pressure 
conditions of 25 ° C and 14.696 psia. Note: it is possible to special order meters 
with a customer specified set of standard conditions. The calibration sheet 
provided with each meter lists its standard conditions.
When performing this comparison it is best to use the smallest transition 
possible between the two devices. Using small transitions will minimize lag and 
dead volume.

RS-232 Serial Communications is not responding.
Check that your meter is powered and connected properly. Be sure that the 
port on the computer to which the meter is connected is active. Confirm that 
the port settings are correct per the RS-232 instructions in this manual (Check 
the RS-232 communications select screen for current meter readings). Close 
Hyperterminal® and reopen it. Reboot your PC. See pages 10, 11 and 30 for 
more information on RS-232 signals and communications.

Slower response than specified.
MC-Series Controllers feature a programmable Geometric Running Average 
(GRA). Depending on the full scale range of the meter, it may have the GRA 
set to enhance the stability/readability of the display, which would result in 
slower perceived response time. Please see “Pressure Averaging” and “Flow 
Averaging” on page 26.

Jumps to zero at low flow.
MC-Series Controllers feature a programmable zero deadband. The factory 
setting is usually 0.5% of full scale. This can be adjusted between NONE and 
3.2% of full scale. See page 26.

Discrepancies between old and new units.
Please see “Standard Gas Data Tables” explanation on page 37.
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Maintenance and Recalibration

General: MC-Series Flow Controllers require minimal maintenance. They 
have no moving parts. The single most important thing that affects the life 
and accuracy of these devices is the quality of the gas being measured. The 
controller is designed to measure CLEAN, DRY, NON-CORROSIVE gases. 

Moisture, oil and other contaminants can affect the laminar flow elements. 
We recommend the use of in-line sintered filters to prevent large particulates 
from entering the measurement head of the instrument. Suggested maximum 
particulate sizes are as follows:

5 microns for units with FS flow ranges of 0-1 sccm or less.
20 microns for units with FS flow ranges between 0-2 sccm and 0-1 slpm.
50 microns for units with FS flow ranges of 0-1 slpm or more.

Recalibration: The recommended period for recalibration is once every year. A 
label located on the back of the controller lists the most recent calibration date. 
The controller should be returned to the factory for recalibration within one 
year from the listed date. Before calling to schedule a recalibration, please note 
the serial number on the back of the instrument. The Serial Number, Model 
Number, and Date of Manufacture are also available on the Model Info display 
(page 28).

Cleaning: MC-Series Flow Controllers require no periodic cleaning. If necessary, 
the outside of the controller can be cleaned with a soft dry cloth. Avoid excess 
moisture or solvents.

For repair, recalibration or recycling of this product contact:

Cole-Parmer Instrument Co.
625 E. Bunker Court

Vernon Hills, IL 60061
USA

Ph. 800-323-4340
Fax 847-549-7676

email: info@coleparmer.com
Website: www.coleparmer.com
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Opti on: Totalizing Mode - Controllers
Controllers can be purchased with the Totalizing Mode opti on. This opti on adds 
an additi onal mode screen that displays the total fl ow (normally in the units of 
the main fl ow screen) that has passed through the device since the last ti me the 
totalizer was cleared. The Totalizing Mode screen is accessed by pushing the 
TOTAL butt on on the MAIN display. 

TOTAL/TIMER: Pushing the TOTAL/TIMER butt on 
will cycle the large numbers on the display 
between total mass and ti me elapsed.
Rollover – The customer can also specify at the 
ti me of order what the totalizer is to do when 
the maximum count is reached. The following 
opti ons may be specifi ed:
No Rollover – When the counter reaches the 
maximum count it stops counti ng unti l the 
counter is cleared.
Rollover – When the counter reaches the 
maximum count it automati cally rolls over to 

zero and conti nues counti ng unti l the counter is cleared.
Rollover with Noti fi cati on – When the counter reaches the maximum count 
it automati cally rolls over to zero, displays an overfl ow error, and conti nues 
counti ng unti l the counter is cleared.

TOTAL MASS: The counter can have as many as seven digits. At the ti me of order, 
the customer must specify the range. This directly aff ects the maximum count. For 
instance, if a range of 1/100ths of a liter is specifi ed on a meter which is totalizing in 
liters, the maximum count would be 99999.99 liters. If the same unit were specifi ed 
with a 1 liter range, the maximum count would be 9999999 liters.
ELAPSED TIME: The small numbers below the mass total show the elapsed ti me 
since the last reset in hours, minutes and seconds. The maximum measurable 
elapsed ti me is 9999 hours 59 minutes 59 seconds. The hours count resets when 
RESET is pushed, an RS-232 clear is executed or on loss of power. Press ELAPSED 
TIME to show this as the primary display.
SETPT: Pushing SETPT will allow you to change the controller's set-point.
RESET – The counter can be reset to zero at any ti me by pushing the RESET 
butt on. To clear the counter via RS-232, establish serial communicati on with the 
meter or controller as described in the RS-232 secti on of the manual. To reset the 
counter, enter the following commands:

In Polling (addressable) Mode:  Address$$T <Enter>  (e.g. B$$T <Enter>)

SETPT
+123.4

MENU

SCCM
+123.4

TOTAL/
TIMER

BATCH RESET

0000:09:59    SCC
00123.45
00123.45 Batch Done

W��� ����� � ���� ���� ���������� �� �� �������� �������� ����������, 
��� ���� ���� ���� ��� ����������� ������ ��� ���� ����������� 
���������� (���� ����� + 28%) �� ��� ����. T��� ��� ����� ���� ��� ���� �� 
����� �� ���� �� ������ �������� ������. 

I� ��� ��������� �� �� ��� �� ���� ����, ��� ��������� ����� ���� ����������� ������ 
���������. P����� ����� ��� ��������� �� ���� �� ‘����-����’ ��������� ��� ��������.  
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BATCH PROCESSING MODE – CONTROLLERS ONLY
Batch mode is a function within the optional Totalizing mode. Batch mode is 
designed to provide repeatable, finite flow quantities. 

To activate Batch Mode: Press BATCH. Then use 
SELECT DIGIT to move the arrow to the desired digit, 
and the UP and DOWN buttons to change the value. 
Press CLEAR to return to zero. Press SET to record 
your value. If the controller has a non-zero Set-Point, 
flow will start immediately. If not, press SETPT to 
select a Set-Point.
Batch values can also be established via RS‑232 
communication using Register 92. (See RS-232 Section of 
this manual for serial communication methods.)
Note: While the Totalizer counter will still reset across 

power cycles, the Batch process value is stored in EEPROM and will remain valid 
until updated by the user.
While the Batch is processing, the desired Batch value is displayed above the 
totalizing counter on the Totalizer screen. Time elapsed during the Batch 
processing is displayed below the totalizing counter. Press TOTAL/TIMER to 
toggle these values.  
When the active Totalizer reaches the preset Batch value, flow ceases, and the 
display updates to “Batch Done”. The Totalizer timer also pauses. 

- To start a new batch of the same size, simply press 
RESET. The Totalizer can reproduce any number of 
fixed Batches in this manner. 
- To start a smaller batch, decrease the Batch value. 
The new batch begins when you press RESET. 
- To continue the existing batch to a larger total 
volume, increase the Batch value. Flow resumes as 
soon as you press OK in the Batch Value screen.
- To start a larger batch from scratch, first clear the 
flow Set-Point to zero to prevent unwanted flow. 

Then increase the Batch value, and select a flow Set-Point. Flow will begin when 
you press SET in the Set-Point screen.
- To cancel a batch in progress, clear the Set-Point and press SET.
Note: Batch mode operates independently of the desired flow rate, but requires 
a non-zero flow rate to run. The rate of flow is determined by the controller 
Set-Point value, which is established by the user via analog, front panel or serial 
communication methods. Batches can be produced more slowly or more rapidly 
as determined by the user-selected Set-Point flow rate.
To turn off Batch Mode: Set the Batch value to zero (0.0) via the front panel or 
RS-232 communication using Register 92. If there is a non-zero flow Set-Point, 
flow will immediately resume, and the Totalizer counter will continue per the 
user established Set-Point flow rate.

DOWN

SET

SELECT 
DIGIT

UP

BACK/ 
CANCEL CLEAR

˄
00123.45

SETPT
123.4

MENU

SCCM
+123.4

TOTAL/ 
TIMER

BATCH RESET

0000:09:59    SCC

00123.45 Batch Done

00123.45
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Accessory: Multi -Drop Box

The Multi -Drop Box makes it convenient to wire 
multi ple fl ow and/or pressure devices to a single RS-232 
port. Now available with a USB interface!

The Multi -Drop Box has nine 8 pin mini-DIN ports 
available. The ports are to be used with a standard 
double ended 8 pin mini-DIN (DC-62) style cable going 
from the box to each fl ow or pressure device. 

A single DB9 D-SUB type connector (COM PORT) connects, using the included 
cable, to the serial connector on a PC or laptop. 

All of the fl ow and/or pressure devices are powered via a terminal block on the 
front of the box. 

If more than nine devices will be required, additi onal Multi -Drop Boxes can be 
daisy chained together with a double ended 8 pin mini-DIN cable plugged into 
any receptacle on both boxes.

Multi -Drop Box Power Supply for Large Valve Controllers: The PS24VHC 
(Power Supply 24Vdc High Current) is a 6.5Amp 24Vdc power supply designed 
for running multi ple large controllers on a Multi -Drop Box. 

The 6.5Amp power supply can run as many as 8 large valve controllers, which 
makes it ideal for the Multi -Drop Box and multi ple large valve (or small valve / 
large valve combinati on) controllers on a Multi -Drop Box.

BB-9 Multi-Drop 
BoxØ .156 Thru 4 Places

1.75

Ø .340 Thru 2 PL

3.46

6.75 1.55

5.06

Multi-Drop Box

Ø .156 Thru 4 Places

1.75

Ø .340 Thru 2 PL

Ø .175 Thru 2 PL

3.46

6.75 1.55

5.06

6.75

7.56
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Accessories
Description

9 position Multi-Drop Box

9 position Multi-Drop Box, Industrial connectors

Universal 100-240 VAC to 24 Volt DC Power Supply Adapter
High current power supply for Multi-Drop Box use with Large Valve 
Controllers
Industrial carry and storage case for portable meters/gauges

8 Pin Male Mini-DIN connector cable, single ended, 6 foot length

8 Pin Male Mini-DIN connector cable, single ended, 25 foot length

8 Pin Male Mini-DIN connector cable, single ended, 30 foot length

8 Pin Male Mini-DIN connector cable, single ended, 50 foot length

8 Pin Male Mini-DIN connector cable, single ended, 75 foot length

8 Pin Male Right Angle Mini-Din Cable, single ended, 6 foot length
8 Pin Male Mini-DIN connector cable, double ended, 6 foot length
8 Pin Male Mini-DIN connector cable, double ended, 25 foot length
8 Pin Male Mini-DIN connector cable, double ended, 50 foot length

8 Pin Male Mini-DIN connector cable, double ended, 60 foot length

8 Pin Male Mini-DIN to DB9 Female Adapter, 6 foot length

DB15 cable, single ended, 25 foot length

Industrial cable, 6 Pin, single ended, 10 foot length

18 gauge industrial cable, 6 Pin, single ended, 10 foot length

Industrial cable, 6 Pin, single ended, 20 foot length

18 gauge industrial cable, 6 Pin, single ended, 24 foot length

Industrial cable, 6 Pin, single ended, 50 foot length

Industrial cable, 6 pin double ended, 10 foot length

RS-232 to USB Converter
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Technical Data for Cole-Parmer MC and MCR Mass Flow Controllers
0 to 0.5 sccm Full Scale through 0 to 3000 slpm Full Scale

Standard Operating Specifications (Contact Cole-Parmer for available options)
Performance MC & MCR Mass Flow Controller

Accuracy at calibration 
conditions after tare ± (0.8% of Reading + 0.2% of Full Scale)

High Accuracy at calibration 
conditions after tare

± (0.4% of Reading + 0.2% of Full Scale)
High Accuracy option not available for units ranged under 5 sccm or over 500 slpm.

Repeatability ± 0.2% Full Scale
Zero Shift and Span Shift 0.02% Full Scale / ºCelsius / Atm

Operating Range / Turndown 
Ratio 0.5% to 100% Full Scale / 200:1 Turndown

Maximum Controllable Flow 
Rate 102.4% Full Scale

Typical Response Time 100 ms (Adjustable) 
Warm-up Time < 1 Second

Communications / Power MC & MCR Mass Flow Controller
Monochrome LCD or Color TFT 

Display with integrated touchpad Simultaneously displays Mass Flow, Volumetric Flow, Pressure and Temperature

Digital Input/Output Signal1 Options RS-232 Serial 

Analog Input/Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA   
Optional Secondary Analog 

Input/Output Signal2 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  

Electrical Connection Options 8 Pin Mini-DIN 15-pin D-sub (DB15) / 6 pin locking
Supply Voltage MC: 12 to 30 Vdc  (15-30 Vdc for 4-20 mA outputs) MCR: 24 to 30 Vdc
Supply Current MC: 0.250 Amp  MCR: 0.750 Amp

1. The Digital Output Signal communicates Mass Flow, Volumetric Flow, Pressure and Temperature  
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate your choice of Mass 

Flow, Volumetric Flow, Pressure or Temperature

Operating Conditions MC & MCR Mass Flow Controller
Mass Reference Conditions (STP) 25ºC & 14.696 psia (standard — others available on request)

Operating Temperature −10 to +50 ºCelsius
Humidity Range 

(Non–Condensing) 0 to 100%

Maximum Pressure 145 psig
Mounting Attitude Sensitivity MC: None MCR: Mount with valve cylinder vertical & upright

Valve Type Normally Closed
Ingress Protection IP40

Wetted Materials

MC: 303 & 302 Stainless Steel, Viton®, Silicone RTV (Rubber), Glass Reinforced 
Nylon, Aluminum, Brass, 430FR Stainless Steel, Silicon, Glass.
MCR: 303 & 302 Stainless Steel, Viton®, Silicone RTV (Rubber), Glass Reinforced 
Nylon, Aluminum, 416 Stainless Steel, Nickel, Silicon, Glass.
If your application demands a different material, please contact Cole-Parmer.

Range Specific Specifications
Full Scale Flow Mass 

Controller
Pressure Drop1 at FS Flow  

(psid) venting to atmosphere
Mechanical 
Dimensions Process Connections2

MC 0.5 sccm to 50 sccm 1.0 3.9”H x 3.4”W x 1.1”D M-5 (10-32) Female Thread 
MC 100 sccm to 500 sccm 1.0

4.1”H x 3.6”W x 1.1”D 1/8” NPT Female

MC 1 slpm 1.5
MC 2 slpm 3.0
MC 5 slpm 2.0
MC 10 slpm 5.5
MC 20 slpm 20.0

MCR 50 slpm 2.0 5.5”H x 7.7”W x 2.3”D 1/4” NPT FemaleMCR 100 slpm 3.2
MCR 250 slpm 2.4 5.5”H x 7.7”W x 2.3”D 1/2” NPT Female
MCR 500 slpm 6.5

5.5”H x 7.4”W x 2.3”D
3/4” NPT Female

(A 1-1/4” NPT Female process 
connection is available for 

2000 slpm controllers.)

MCR 1000 slpm 14.0
MCR 1500 slpm 17.0
MCR 2000 slpm 28.6 5.5”H x 8.1” W x 2.9” D
MCR 3000 slpm 16.8 5.5”H x 8.9” W x 2.9” D 1-1/4” NPT Female

1. Lower Pressure Drops Available, please see our MCW-Series mass flow controllers. 
2. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and 
SAE connections upon request.
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



















  









MC-Series:
0 - 100 sccm
0 - 200 sccm
0 - 500 sccm
0 - 1 slpm
0 - 2 slpm
0 - 3 slpm
0 - 5 slpm
0 - 10 slpm
0 - 20 slpm

MC-Series:
0 - 0.5 sccm
0 - 1 sccm
0 - 2 sccm
0 - 5 sccm
0 - 10 sccm
0 - 20 sccm
0 - 50 sccm








 








   











0.5 sccm to 50 sccm approximate shipping weight: 1.1 lb.

100 sccm to 20 slpm approximate weight: 1.2lb
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 







































 










MCR-Series:
0 - 50 slpm
0 - 100 slpm




















 
























MCR-Series:
0 - 250 slpm

MCR 50 slpm to 100 slpm approximate weight: 9.0 lb. 

MCR 250 slpm approximate weight: 9.0 lb. 
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  















 








 





 









MCR-Series:
0 - 500 slpm
0 - 1000 slpm
0 - 1500 slpm


















 







 



 










    

MCR-Series:
0 - 2000 slpm

MCR 1500 slpm approximate weight: 9.0 lb.

MCR 2000 slpm approximate weight: 12.0 lb.
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



 






 










 



 

 









 



MCR-Series:
0 - 3000 slpm

MCR 3000 slpm approximate weight: 12.0 lb.
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Technical Data for MCW Low Pressure Drop Mass Flow Controllers
0 to 0.5 sccm Full Scale through 0 to 500 slpm Full Scale

Performance MCW & MCRW Mass Flow Controller
Accuracy at calibration 

conditions after tare ± (0.8% of Reading + 0.2% of Full Scale)

High Accuracy at calibration 
conditions after tare

± (0.4% of Reading + 0.2% of Full Scale)
High Accuracy option not available for units ranged under 5 sccm or over 500 slpm.

Repeatability ± 0.2% Full Scale
Zero Shift and Span Shift 0.02% Full Scale / ºCelsius / Atm

Operating Range / Turndown Ratio 0.5% to 100% Full Scale / 200:1 Turndown
Maximum Controllable Flow Rate 102.4% Full Scale

Typical Response Time 100 ms (Adjustable) 
Warm-up Time < 1 Second

Standard Specifications (Contact Cole-Parmer for available options.)

Communications / Power MCW & MCRW Mass Flow Controller
Monochrome LCD or Color TFT 

Display with integrated touchpad Simultaneously displays Mass Flow, Volumetric Flow, Pressure and Temperature

Digital Input/Output Signal1 Options RS-232 

Analog Input/Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA   
Optional Secondary Analog 

Input/Output Signal2
0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  

Electrical Connection Options 8 Pin Mini-DIN / 6 pin locking
Supply Voltage MCW: 12 to 30 Vdc  (15-30 Vdc for 4-20 mA outputs) MCRW: 24 to 30 Vdc
Supply Current MCW: 0.250 Amp  MCRW: 0.750 Amp

1. The Digital Output Signal communicates Mass Flow, Volumetric Flow, Pressure and Temperature              
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate your choice of Mass 

Flow, Volumetric Flow, Pressure or Temperature

Operating Conditions MCW & MCRW Mass Flow Controller
Mass Reference Conditions (STP) 25ºC & 14.696 psia (standard — others available on request)

Operating Temperature −10 to +50 ºCelsius
Humidity Range 

(Non–Condensing) 0 to 100%

Maximum Pressure 50 psig         Higher line pressures available, please contact Cole-Parmer.
Mounting Attitude Sensitivity MCW: None MCRW: Mount with valve cylinder vertical & upright

Valve Type Normally Closed
Ingress Protection IP40

Wetted Materials

MCW: 303 & 302 Stainless Steel, Viton®, Silicone RTV (Rubber), Glass Reinforced 
Nylon, Aluminum, Brass, 430FR Stainless Steel, Silicon, Glass.
MCRW: 303 & 302 Stainless Steel, Viton®, Silicone RTV (Rubber), Glass Reinforced 
Nylon, Aluminum, 416 Stainless Steel, Nickel, Silicon, Glass.
If your application demands a different material, please contact Cole-Parmer.

Range Specific Specifications
Full Scale Flow Mass 

Controller
Pressure Drop at FS Flow 

(psid) venting to atmosphere
Mechanical 
Dimensions Process Connections1

MCW 0.5 sccm to 2 sccm 0.06
3.9”H x 3.4”W x 1.1”D M-5 (10-32) Female 

ThreadMCW 5 sccm to 10 sccm 0.08
MCW 20 sccm 0.07

MCW 50 sccm to 200 sccm 0.07

4.1”H x 3.6”W x 1.1”D 1/8” NPT Female
MCW 500 sccm 0.08

MCW 1 slpm 0.10
MCW 2 slpm 0.18

MCRW 5 slpm 0.10
5.5”H x 7.7”W x 2.3”D 1/4” NPT FemaleMCRW 10 slpm 0.12

MCRW 20 slpm 0.26
MCRW 40 slpm 0.14 5.5”H x 7.7”W x 2.3”D 1/2” NPT Female
MCRW 50 slpm 0.17

5.5”H x 7.3”W x 2.3”D 3/4” NPT FemaleMCRW 100 slpm 0.30
MCRW 250 slpm 0.69
MCRW 500 slpm 0.69 5.5”H x 8.1”W x 2.7”D 3/4” NPT Female

1. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and 
SAE connections upon request.
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MCW:
0 - 0.5 sccm
0 - 1 sccm
0 - 2 sccm
0 - 5 sccm
0 - 10 sccm
0 - 20 sccmMCW 0.5 sccm to 20 sccm approximate shipping weight: 1.1 lb.

MCW:
0 - 50 sccm
0 - 100 sccm
0 - 200 sccm
0 - 500 sccm
0 - 1 slpm
0 - 2 slpm


































  



















 






   





MCW 50 sccm to 2 slpm approximate weight: 1.2lb



61







 









 














 

 








MCRW:
0 - 5 slpm
0 - 10 slpm
0 - 20 slpm 

MCRW 5 slpm to 20 slpm approximate weight: 6.4 lb.

MCRW 40 slpm approximate weight: 9.0 lb. 







 











  








 





 


MCRW:
0 - 40 slpm
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 















   












 

 









 





MCRW 50 slpm to 250 slpm approximate weight: 9.0 lb. 


















 





 




 







     

MCRW 500 slpm approximate weight: 11.0 lb. 

MCRW:
0 - 500 slpm 

MCRW:
0 - 50 slpm 
0 - 100 slpm 
0 - 250 slpm 
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Technical Data for MCV & MCVS Mass Flow Controllers
0 to 0.5 sccm Full Scale through 0 to 20 slpm Full Scale

The Cole-Parmer MCV mass flow controller is designed for applications that require tight shut-off such as 
vacuum coating and sputtering processes. An integrated pneumatic shut-off valve is normally closed and 
provides positive shut-off of 1 x 10-9 atm scc/sec Helium max. 
MCVS controllers are for use with aggressive gases.

Performance MCV Mass Flow Controller MCVS Mass Flow Controller
Accuracy at calibration conditions 

after tare ± (0.8% of Reading + 0.2% of Full Scale)

High Accuracy at calibration conditions 
after tare

± (0.4% of Reading + 0.2% of Full Scale)
High Accuracy option not available for units ranged under 5 sccm.

Repeatability ± 0.2% Full Scale
Zero Shift and Span Shift 0.02% Full Scale / ºCelsius / Atm

Operating Range / Turndown Ratio 0.5% to 100% Full Scale / 200:1 Turndown 1% to 100% Full Scale / 100:1 Turndown
Maximum Controllable Flow Rate 102.4% Full Scale

Typical Response Time 100 ms (Adjustable) 
Warm-up Time < 1 Second

Integrated Valve Leak Integrity 1 x 10-9 atm scc/sec Helium max

Standard Specifications (Contact Cole-Parmer for available options.)

Operating Conditions MCV Mass Flow Controller MCVS Mass Flow Controller
Mass Reference Conditions (STP) 25ºC & 14.696 psia (standard — others available on request)

Operating Temperature −10 to +50 ºCelsius
Humidity Range (Non–Condensing) 0 to 100%

Maximum Pressure 145 psig
Mounting Attitude Sensitivity None 

Valve Type Normally Closed
Ingress Protection IP40

Wetted Materials

MCV: 316L,303 & 302 Stainless Steel, Viton®, Silicone RTV (Rubber), Glass Reinforced 
Nylon, Aluminum, Brass, 430FR Stainless Steel, Silicon, Glass, PCTFE.
MCVS: 316LSS, 303SS, 430FRSS, FFKM (Kalrez) standard, Viton, EPDM, Buna, Neo-
prene as needed for some gases.
If your application demands a different material, please contact Cole-Parmer.

Communications / Power MCV & MCVS Mass Flow Controller
Monochrome LCD or Color TFT 

Display with integrated touchpad Simultaneously displays Mass Flow, Volumetric Flow, Pressure and Temperature

Digital Input/Output Signal1 Options RS-232

Analog Input/Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA   
Optional Secondary Analog 

Input/Output Signal2
0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  

Electrical Connection Options 8 Pin Mini-DIN / 6 pin locking
Supply Voltage 12 to 30 Vdc  (15-30 Vdc for 4-20 mA outputs)
Supply Current 0.250 Amp 

1. The Digital Output Signal communicates Mass Flow, Volumetric Flow, Pressure and Temperature              
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate your choice of Mass 

Flow, Volumetric Flow, Pressure or Temperature

Range Specific Specifications
Full Scale Mass Flow Controller Mechanical Dimensions Process Connections

MCV 0.5SCCM to 20SLPM 4.8”H x 6.8”W x 1.5”D 1/4” VCR® Male
MCVS 0.5SCCM to 20SLPM 5.5”H x 6.8”W x 1.5”D 1/4” VCR® Male

Welded VCR® process connections are recommended for MCV  and MCVS applications. Please contact Cole-Parmer.
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











 
















MCV-Series
All ranges

MCV approximate weight: 3.0 lb.



 























MCVS-Series
All ranges

MCVS approximate weight: 3.2 lb.



65

Technical Data for MCP Moderate Flow Mass Flow Controllers
0 to 50 slpm Full Scale through 0 to 250 slpm Full Scale

Cole-Parmer MCP mass flow controllers are fitted with a high performance valve for low pressure 
applications. The following specifications are applicable to MCP-Series Mass Flow Controllers only.
Please Note Maximum Pressure of 80 psig.
Standard Operating Specifications (Contact Cole-Parmer for available options)

Performance MCP Mass Flow Controller
Accuracy at calibration conditions 

after tare ± (0.8% of Reading + 0.2% of Full Scale)

High Accuracy at calibration conditions 
after tare ± (0.4% of Reading + 0.2% of Full Scale)

Repeatability ± 0.2% Full Scale
Zero Shift and Span Shift 0.02% Full Scale / ºCelsius / Atm

Operating Range / Turndown Ratio 0.5% to 100% Full Scale / 200:1 Turndown
Maximum Controllable Flow Rate 102.4% Full Scale

Typical Response Time 100 ms (Adjustable) 
Warm-up Time < 1 Second

Communications / Power MCP Mass Flow Controller
Monochrome LCD or Color TFT 

Display with integrated touchpad Simultaneously displays Mass Flow, Volumetric Flow, Pressure and Temperature

Digital Input/Output Signal1 Options RS-232  

Analog Input/Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA   
Optional Secondary Analog 

 Input/Output Signal2
0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  

Electrical Connection Options 8 Pin Mini-DIN 6 pin locking
Supply Voltage 12 to 30 Vdc  (15-30 Vdc for 4-20 mA outputs)
Supply Current 0.250 Amp 

1. The Digital Output Signal communicates Mass Flow, Volumetric Flow, Pressure and Temperature  
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate your choice of Mass 

Flow, Volumetric Flow, Pressure or Temperature

Operating Conditions MCP Mass Flow Controller
Mass Reference Conditions (STP) 25ºC & 14.696 psia (standard — others available on request)

Operating Temperature −10 to +50 ºCelsius
Humidity Range 

(Non–Condensing) 0 to 100%

Maximum Pressure 80 psig
Mounting Attitude Sensitivity None 

Valve Type Normally Closed
Ingress Protection IP40

Wetted Materials
303 & 302 Stainless Steel, Viton®, Silicone RTV (Rubber), Glass Reinforced Nylon, 
Aluminum, Brass, 410 &416 Stainless Steel.
If your application demands a different material, please contact Cole-Parmer.

Range Specific Specifications
Full Scale Flow Mass 

Controller
Pressure Drop1 at FS Flow  

(psid) venting to atmosphere
Mechanical 
Dimensions Process Connections2

MCP 50 slpm 7 4.4”H x 5.4”W x 1.6”D 1/4” NPT FemaleMCP 100 slpm 20
MCP 250 slpm 60 5.0”H x 6.3”W x 1.6”D 1/2” NPT Female

1. Lower Pressure Drops Available, please see our MCW-Series mass flow controllers.
2. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and 
SAE connections upon request.
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










  
  








 





















  








 









MCP-Series: 
50 slpm
100 slpm

MCP-Series: 
250 slpm

10 slpm to 50 slpm approximate shipping weight: 3.0 lb.

100 slpm to 250 slpm approximate shipping weight: 4.4 lb.
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Technical Data for MCS and MCRS-Series Mass Flow Controllers
Cole-Parmer MCS and MCRS instruments are built for use with aggressive gases. 
For the most part, these instruments maintain the specifications of equivalently 
ranged MC and MCR-Series devices. 

Please refer to Cole-Parmer’s Technical Data and Specifications for the 
equivalently ranged MC and MCR-Series instrument for all operating 
specifications except:

Operating Range 1% to 100% Full Scale
Turndown Ratio 100 : 1

Wetted Materials 316LSS, 303SS, 430FRSS, FFKM (Kalrez) standard, 
Viton, EPDM as needed for some gases.

The dimensions of MCS and MCRS instruments may vary from their standard 
MC and MCR-Series counterparts. Dimensional drawings for MCS and MCRS 
instruments are shown on pages 68 -71

Standard Compatible Gas List for MCS and MCRS Controllers

0 Air Air
1 Argon     Ar
2 Methane   CH4
3 Carbon Monoxide  CO
4 Carbon Dioxide   CO2
5 Ethane  C2H6
6 Hydrogen  H2
7 Helium   He
8 Nitrogen  N2
9 Nitrous Oxide N2O

10 Neon  Ne
11 Oxygen  O2
12 Propane  C3H8
13 normal-Butane  n-C4H10
14 Acetylene  C2H2
15 Ethylene  C2H4
16 iso-Butane  i-C4H10
17 Krypton  Kr
18 Xenon  Xe
19 Sulfur Hexafluoride SF6
20 75%Ar / 25% CO2 C-25
21 90% Ar / 10% CO2 C-10
22 92% Ar / 8% CO2 C-8

23 98% Ar / 2% CO2 C-2
24 75% CO2 / 25% Ar C-75
25 75% Ar / 25% He HE-75
26 75% He / 25% Ar HE-25

27
90% He / 7.5% Ar / 

2.5% CO2
 Helistar® A1025

A1025

28
90% Ar / 8% CO2 / 

2% O2
Stargon® CS

Star29

29 95% Ar / 5% CH4 P-5
30 Nitric Oxide NO
31 Nitrogen Triflouride NF3
32 Ammonia NH3
34 Hydrogen Sulfide H2S
36 Propylene C3H6
In addition, the following gases are 
available upon request: 
Nitrogen Dioxide to 0.5% 
in an inert carrier NO2

Refrigerant gases to 100%
Other gases to 1000 ppm in an inert 
carrier

If your application requires another gas or gas mixture, please contact Cole-
Parmer.
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MCS-Series:
0 – 0.5 sccm
0 – 1 sccm
0 – 2 sccm
0 – 5 sccm
0 – 10 sccm
0 – 20 sccm
0 – 50 sccm

MCS-Series:
0 – 100 sccm
0 – 200 sccm
0 – 500 sccm
0 – 1 slpm
0 – 2 slpm
0 – 5 slpm
0 – 10 slpm
0 – 20 slpm

0.5 sccm to 50 sccm approximate shipping weight: 1.1 lb.

100 sccm to 20 slpm approximate weight: 1.2 lb
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



















 

 










 










 

MCRS-Series:
0 – 50 slpm
0 – 100 slpm

MCRS 50 slpm to 100 slpm approximate weight: 9.0 lb.





 

 

 

































MCRS-Series:
0 – 250 slpm

MCRS 250 slpm approximate weight: 9.0 lb. 
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MCRS-Series:
0 – 500 slpm
0 – 1000 slpm
0 – 1500 slpm

MCRS-Series:
0 – 2000 slpm

MCRS 500 slpm to 1500 slpm approximate weight: 9.0 lb. 

MCRS 2000 slpm approximate weight: 12.0 lb.



71








 




 



 



















 



 



MCRS-Series:
0 – 3000 slpm

MCRS 3000 slpm approximate weight: 12.0 lb.
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Eight Pin Mini-DIN Connector Pin-Outs
If your instrument was ordered with the standard Eight Pin Mini-DIN 

connection, please be sure to reference the following pin-out diagram.

Standard 8 Pin Mini-DIN Pin-Out



 







1 2

3 4 5

6 7 8

Pin Function Mini-DIN 
cable color

1 Inactive (or optional 4-20mA Primary Output Signal) Black

2 Static 5.12 Vdc [or optional Secondary Analog Output (4-20mA, 
5Vdc, 10Vdc) or Basic Alarm] Brown

3 Serial RS-232RX (receive) Input Signal Red

4 Meters/Gauges = Remote Tare (Ground to Tare)
Controllers = Analog Set-Point Input Orange

5 Serial RS-232TX (send) Output Signal Yellow
6 0-5 Vdc (or optional 0-10 Vdc) Output Signal Green
7 Power In (as described above) Blue

8 Ground (common for power, digital communications, analog signals 
and alarms) Purple

Note: The above pin-out is applicable to all the flow meters and controllers with the 
Mini‑DIN connector. The availability of different output signals depends on the options 
ordered. Optional configurations are noted on the unit’s calibration sheet.
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The above pin-out is applicable to all the flow meters and controllers ordered with the 
industrial connector. The availability of different output signals depends on the flow 
meter options ordered.

The locking industrial connector is standard on all CSA/ATEX approved devices. 

Locking Industrial Connector Pin-Outs
If your instrument was ordered with a Six Pin Locking Industrial 

connection, please be sure to reference the following pin-out diagram.

Pin Function
1 Power In  ( + )
2 RS-232TX 
3 RS-232RX 
4 Meters/Gauges = Remote Tare (Ground to Tare)

Controllers = Analog Set-Point Input
5 Ground (common for power, communications and signals)
6 Signal Out (Voltage or Current as ordered)

Male Connector: Cable Female Connector: Device
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Additional Information for CSA and ATEX Approved Devices
See the following page for Special Conditions regarding the use of these units!

EEx nA IIC T4 
Class I, Div. 2 Group A, B, C and D T4

24 Vdc, 0.800A max
Class I, Zone 2 AEx nA IIC T4

WARNINGS: 

EXPLOSION HAZARD – DO NOT DISCONNECT WHILE CIRCUIT IS 
LIVE UNLESS AREA IS KNOWN TO BE NON-HAZARDOUS.

EXPLOSION HAZARD – SUBSTITUTION OF COMPONENTS MAY 
IMPAIR SUITABILITY FOR CLASS I, DIVISION 2.

II 3 G

Industrial Connector Overall Clearance
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All CSA / ATEX approved devices are equipped with a locking 6 pin industrial 
connector. The power and signal connections are shown below.

Clearance Requirements for 
Industrial Connector

Pin Function
1 Power In  ( + )
2 RS-232TX 
3 RS-232RX 
4 Remote Tare Meters (Ground to Tare)

Analog Set-Point Input (Controllers)
5 Ground (common for power, 

communications and signals)
6 Signal Out (Voltage or Current as 

ordered)
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USE of instruments  (M, MW, MS, MC, MCW, MCS, MCR, MCRW, MCRS, P, PS, PC, PCS, 
PCR and PCRS product families only) in Class 1 Division 2 applications.

CSA certifies the use of this product for general use as well as use in hazardous 
locations as defined by Class 1 Division 2 Group A, B, C and D T4. 
 CSA certification is indicated by the product label as shown below and 
not by the statements in this, or any accompanying documentation.

Special Conditions:
To comply with CSA certification the following information is included in the product literature:

•	 When equipment is properly labeled, it is suitable in Class I, Division 2, Group A, B, 
C and D, T4

o	 Tamb. -40°C to +50°C 
•	 Electrical Rating 24Vdc, 0.800A max
•	 Instruments shall be powered by a CSA certified, UL listed, Class II external power 

supply suitable for the application
•	 Instruments shall be housed in an enclosure with a minimum IP54 rating or location 

providing equivalent protection
•	 Instrument’s final approval shall be provided by the local authority having jurisdiction

EEx nA IIC T4 
Class I, Div. 2 Group A, B, C and D T4

24 Vdc, 0.800A max
Class I, Zone 2 AEx nA IIC T4

X – See manual for special conditions
WARNINGS: 

EXPLOSION HAZARD – DO NOT 
DISCONNECT WHILE CIRCUIT IS LIVE 
UNLESS AREA IS KNOWN TO BE  
NON-HAZARDOUS.
EXPLOSION HAZARD – SUBSTITUTION 
OF COMPONENTS MAY IMPAIR 
SUITABILITY FOR CLASS I, DIVISION 2.

II 3 G

232422

USE of instruments (M, MS, MC, MCS, MCR, MCRS, P, PS, PC, PCS, PCR and PCRS 
product families only) in applications requiring ATEX Certification.

Properly labeled instruments comply to the following ATEX standard:

II 3 G EEx nA IIC T4 (-40°C ≤ Ta ≤ +50°C)
The examination certificate was issued by the CSA in accordance with accepted 
practices and procedures. This confirms compliance with the European ATEX 

Directive or Group II Category 3G equipment.
ATEX certification is indicated by the product label as shown above and not by the 
statements in this, or any accompanying documentation.
Special Conditions:

•	 Properly labeled equipment is only certified for use in ambient temperatures in the 
range of -40°C to +50°C only

•	 Electrical Rating 24Vdc, 0.800A max
•	 Instruments shall be powered by a CSA certified, UL listed, Class II external power 

supply suitable for the application
•	 Instruments shall be housed in an enclosure with a minimum IP54 rating or location 

providing equivalent protection
•	 Instrument’s final approval shall be provided by the local authority having jurisdiction
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Model Number: _________________________


